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Warranty and liability 
 

Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These Application Examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
Application Examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 

Security 
informa-
tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber 
threats, it is necessary to implement – and continuously maintain – a holistic, 
state-of-the-art industrial security concept. Siemens’ products and solutions only 
form one element of such a concept. 
Customer is responsible to prevent unauthorized access to its plants, systems, 
machines and networks. Systems, machines and components should only be 
connected to the enterprise network or the internet if and to the extent necessary 
and with appropriate security measures (e.g. use of firewalls and network 
segmentation) in place.  
Additionally, Siemens’ guidance on appropriate security measures should be 
taken into account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity.  

Siemens’ products and solutions undergo continuous development to make them 
more secure. Siemens strongly recommends to apply product updates as soon 
as available and to always use the latest product versions. Use of product 
versions that are no longer supported, and failure to apply latest updates may 
increase customer’s exposure to cyber threats. 
To stay informed about product updates, subscribe to the Siemens Industrial 
Security RSS Feed under http://www.siemens.com/industrialsecurity. 

 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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Preface 

Introduction 

There are various automation systems available for the SIMATIC PCS 7 process 
control system which differ in performance, quantity structure, communications 
interfaces and scalability, among other things. These include:  

• AS 410 automation systems  

• Complementary S7-400 systems (AS 412 to AS 417) 

Depending on the automation performance requirements, CPU 412 to CPU 417 
may be used on the complementary S7-400 systems. If the performance limit of 
one of the CPUs being used is reached, e.g., as a result of necessary modifications 
to the user program, the hardware must be exchanged to increase the 
performance, or a higher performance S7-400 system used.  

The AS 410 offers a CPU – the innovative CPU 410-5H Automation – which is 
versatile in use. The automation performance is scaled without having to change the 
CPU and is effected by means of the number of PCS 7 process objects. In this case 
the best performance is always available regardless of the area of application.  
The reduction of types on the AS 410 to a single CPU brings numerous benefits.  
It simplifies considerably the selection, configuration and planning of the automation 
system, as well as replacement parts holding and plant expansion. 

Document contents 

In this document, scenarios are described which explain relevant functions of the 
CPU 410-5H Process Automation in the AS 410 and illustrate advantages compared 
to the complementary S7-400 systems. Additionally you will gain an overview of 
important configuration steps and hints.  

You will find information on the following topics in the document: 

• General information on the CPU 410-5H Process Automation 

• Advantages of the CPU 410-H 

• Configuring the communications interface and establishing the connection 
between the ES and the AS  

• Type Change in RUN (TCiR) function 

• Configuration of the PN/Ethernet interfaces 

• Online upgrade of process objects 

Validity 

This application applies to: 

• CPU 410-5H Process Automation, Firmware Version 8.1 

• SIMATIC PCS 7 V8.2 
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1 CPU 410-5H at a glance 
In this chapter you will find general information on the CPU 410-5H, its functions 
and areas of application. 

1.1 Introduction 

The CPU 410-5H is a controller specially designed for process automation which is 
versatile in use. With its robust, high performance hardware, the CPU 410-5H 
covers the entire performance spectrum of the AS 412 to AS 417 complementary 
systems. 

Scalable performance 

The performance range of the CPU 410-5H can be individually scaled according to 
the size and type of the PCS 7 applications. This is done by means of the PO 
volume, which is determined by the System Expansion Card (SEC). The volume 
extends from 100 PO to unlimited, at which point other performance data of the 
CPU acts as the limiting factor. 

The PO quantity structure of an SEC can be conveniently extended from the PCS 7 
V8.1 by means of CPU 410 expansion packs. It is not necessary to dismantle the 
CPU or the SEC. There are CPU 410 expansion packs available for 100 POs and 
500 POs. You have the following options when ordering CPU 410 expansion packs: 

• Online via http://www.siemens.com/industrymall 

• Through your Siemens contact person (www.siemens.com/automation/partner) 

Communication 

The CPU has two 10/100 MBit/s PN/Ethernet interfaces, which can be configured 
as follows: 

• 2x PROFINET, e.g., for redundant configurations without the use of external CPs  

• 1x Industrial Ethernet and 1x PROFINET, e.g., for connecting to the plant bus 
and the process bus without the use of external CPs.    

• 2x Industrial Ethernet, e.g., to design redundancy into the plant bus 

Additionally, the CPU has a 12 MBit/s PROFIBUS interface and allows the 
connection of up to 96 nodes. The distributed process I/O can be linked either 
directly (PROFIBUS DP) or via a subordinate process bus (PROFIBUS PA). 

http://www.siemens.com/industrymall
file:///C:/Users/z003thbf/Downloads/www.siemens.com/automation/partner
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The PROFINET interfaces can be used for connecting or expanding the I/O 
devices. 250 devices can be connected for each PROFINET interface. 

 

 

Process safety functions 

The SIMATIC PCS 7 CPU 410 is set up as standard for integrated process safety 
functions and offers all the functions required for safety-oriented applications. The 
controller is TÜV certified and meets all safety requirements up to SIL 3. The CPU is 
capable of multitasking, meaning that several programs can run simultaneously - 
both Basic Process Control Applications (BPCS) and safety-oriented applications. 
The programs are also reaction-free, with the result that potential errors in the BPCS 
applications have no effect on the safety-oriented applications and vice versa. 

General information 

Two redundant, galvanically isolated controllers are used to guarantee maximum 
availability. They can be mounted on a common rack or also operated 
synchronously at a distance of up to ten kilometers from one another. In this case, 
one of the two CPUs functions as the master and the other as the reserve. In each 
case two synchronization submodules are used for redundant coupling, the two 
CPUs being synchronized by means of fiber-optic cables. The modules can be 
exchanged during operation. 
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1.2 Advantages of the CPU 410-5H 

General information 

The CPU 410-5H offers, among others, the following advantages: 

• A hardware platform for all application uses, application sizes and performance 
ranges.  

Consequently the selection, configuration and planning of the automation 
system are simplified. 

• Lower costs for spare or replacement part inventories, as only one CPU type is 
used in the project. 

• Flexible expansion of the automation performance without replacing hardware 

• Lower investment costs and greater possibilities for use in regions with coating 
requirements, due to the protective coating of the CPU 410-5H 

• Reduction of plant downtime due to the possibility of type updating of AS 
blocks in RUN mode (TCiR). 

System planning 

The advantages of the CPU 410-5H come into their own above all when planning a 
new plant: 

• When planning the automation performance necessary for your plant, you will 
no longer have to consider different CPU variants, as the CPU 410-5H can be 
used for all purposes (e.g. as an H or an F system, as well as for all application 
sizes).  

• The required automation performance (PO volumes) can be ordered according 
to the application size after the engineering phase is complete.  

• The automation performance can be conveniently expanded as required at any 
time by means of the CPU System Expansion Card (SEC), without any 
exchange of hardware or plant downtime.  

• The planning of the CPU spares is simplified considerably by the use of 
standardized hardware. In this case you will only need one CPU 410-5H 
without SEC as a replacement part, since the SEC can be transferred if the 
CPU is exchanged. 

• Due to networking with PROFINET (PN), switchgear and drives can be 
reached by every CPU without expensive cabling. Should program relocations 
to another CPU arise in the course of the implementation, it will not be 
necessary to rewire the station or the device. 

 

Note The PN communication which spans the CPUs can influence the performance 
capability of all the CPUs in the PN network. 

 



2 Application scenarios 

2.1 Configuring the communications interface and 
establishing the connection between the ES and the AS 
 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V2.2,    11/2016   8 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2 Application scenarios 

2.1 Configuring the communications interface and 
establishing the connection between the ES and the AS 

In order to implement the application scenarios described in this chapter, a 
connection must be set up between the Engineering Station (ES) and the 
Automation System. The configuration procedure depends on the communications 
interface used. A distinction is made between:  

• AS with additional CP 

• Internal PN/Ethernet interfaces of the CPU 

2.1.1 Establishing a connection using an additional CP in the AS 

The following will describe how to establish a connection between ES and AS 
using the CP 443-1. 

Requirement 

In order to establish a connection between the ES and the AS (via the CP), the 
modules must be fitted in the rack as shown in the operating manual. 

Preliminary considerations 

Before establishing communication, you must define whether you want to use 
TCP/IP or ISO. Addressing (IP address, MAC address) is carried out on the basis 
of the interface selection. 
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Connection via ISO interface 

The following points are a step-by-step description of how to establish the 
connection between the AS and the ES. 

1. Configure the AS in the HW Config. and assign the address for the CP  
(MAC address) accordingly. 

 

 

2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC station..." 
to set the "Interface parameter setting used" to "ISO" (e.g., CP1623.ISO.1). 

4. Switch back to the HW Config. 

5. Execute the menu command "Target system > Load in module...". 
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6. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 
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7. If you have not changed the MAC address for the CP (configured MAC 
address is the same as the factory-set MAC address), click on the "OK" button 
in the "Select Node Address" dialog window. 

 

 

 

  

 



2 Application scenarios 

2.1 Configuring the communications interface and 
establishing the connection between the ES and the AS 
 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V2.2,    11/2016   12 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

If you have configured a different MAC address, then click on the "View" button. 
Then in the "Accessible Nodes" box, select the CP from which you want to load the 
configuration. Now click the "OK" button. 

 

 

8. The configuration has now been loaded into the AS.  

 

Note After an address change, always load the configuration via the HW Config or 
NetPro. The accessible nodes to which you can make assignments by loading a 
new address are only shown here. When loading from the SIMATIC Manager, an 
attempt will be made to load via the configured address. Since this cannot be 
accessed, the loading procedure will be aborted, accompanied by an appropriate 
message. 
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Connection via TCP/IP interface 

The following points are a step-by-step description of how to establish the 
connection between the AS and the ES. 

1. Configure the AS in the HW Config. and assign the IP parameters for the CP  
(IP address, subnet mask) accordingly. 

 

 

2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC station..." to 
set the "Interface parameter setting used" to "RFC1006" or "TCPIP" (e.g., 
CP1623.RFC1006.1). 

4. Switch back to the HW Config. 

5. Execute the menu command "Target system > Edit Ethernet Node". 
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6. Click on the "Browse" button in the "Edit Ethernet Node" dialog window. 
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7. In the "Browse Network" dialog window, select the CP by means of the MAC 
address and click on the "OK" button. 

 

 

Note 

 

If not all or none of the connected nodes are displayed, check the settings for the 
used network components (switches,...). 
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8. The MAC address and the IP parameters for the CP are entered in the  
"Edit Ethernet Node" dialog window. Adapt the IP parameters according to 
your configuration in HW Config (see Step 1). Next click on the "Assign IP 
Configuration" button and then on the "Close" button. 

 

 

Note If you start the search again, you can check to see if the parameters have been 
correctly accepted. 
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9. Execute the menu command "Target system > Load in module...". 

10. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 
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11. In the "Enter connection to target station" box in the "Select Node Address" 
dialog window, select the relevant IP address and click on the "OK" button. 

 

 

12. The configuration has now been loaded into the AS. 
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2.1.2 Establishing a connection via internal PN/Ethernet interfaces of the CPU 

The following describes how to establish a connection between the ES and the AS 
using the internal PN/Ethernet interfaces of the CPU 410-5H. 

Requirement 

In order to establish a connection between the ES and the AS using the internal 
interfaces of the CPU 410-5H, the CPU 410-5H must be fitted in the rack as shown 
in the operating manual and be connected to the ES via the network (Ethernet). 

Preliminary considerations 

Before configuring, define which interface is to be used to connect the CPU to the 
plant bus. An IP address from the address range of the plant bus must be used for 
the interface. 

 

Note The ISO protocol is not supported by the internal PN/Ethernet interfaces. 
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Connection via PN/Ethernet interface 

The following points are a step-by-step description of how to establish the initial 
connection between the CPU 410-5H and the ES. 

1. Configure the AS in the HW Config. and assign the IP parameters (IP address, 
subnet mask) on the PN/Ethernet interface. 

 

 

2. Save and compile the configuration. 

3. In the SIMATIC Manager, use menu command "Tools > Set PG/PC station..." to set 
the "Interface parameter setting used" to "RFC1006" or "TCPIP" (e.g., 
CP1623.RFC1006.1). 

4. Switch to the HW Config. 

5. Execute the menu command "Target system > Edit Ethernet Node". 
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6. Click on the "Browse" button in the "Edit Ethernet Node" dialog window. 

 

 

  

 



2 Application scenarios 

2.1 Configuring the communications interface and 
establishing the connection between the ES and the AS 
 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V2.2,    11/2016   22 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

7. In the "Browse Network" dialog window, select the CPU by means of the MAC 
address and click on the "OK" button. 

 

 

Note If not all or none of the connected nodes are displayed, check the settings for the 
used network components (switches,...). 
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8. The MAC address and the IP parameters for the Ethernet interface are entered 
in the "Edit Ethernet Node" dialog window. Adapt the IP parameters according 
to your configuration in HW Config (see Step 1). Next, click on the "Assign IP 
Configuration" button and then on the "Close" button. 

 

 

Note If you start the search again, you can check to see if the parameters have been 
correctly accepted. 
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9. Execute the menu command "Target system > Load in module...". 

10. In the "Select Target Module" dialog window, select the relevant module and 
click on "OK". 
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11. In the "Enter connection to target station" box in the "Select Node Address" 
dialog window, select the relevant IP address and click on the "OK" button. 

 

 

12. The configuration has now been loaded into the AS. 
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2.2 Loading interface changes from AS blocks in RUN 
mode (TCiR) 

Introduction 

The CPU 410-5H V8.1 supports type updating with interface changes in RUN 
mode (Type Change in RUN (TCiR)). It is thus possible to update the instances 
after an interface change to block types and load them into the target system in 
RUN mode. With the TCiR function you can, for example, also update a library 
without having to put the CPU in the STOP state (see Chapter 2.3). 
 

CAUTION Note that you must create new blocks (new number) for the instances of 
the changed block types that were loaded into the CPU by means of TCiR. 
The system deactivates the blocks in WinCC until the OS server has be 
been re-compiled and loaded. 

In the case of a redundant OS server, you can do this before loading AS 
TCiR and loading one of the servers. This means that the plant can be 
operated before and after AS TCiR loading. 

Note, however, that when doing this data can be lost in the area of 
archiving. 

 

CAUTION The following changes to the block can only be loaded in STOP mode: 

• Changed name of an input with configured message  
("Message Event ID") 

 

Note You can find a detailed description of TCiR in the CFC online help system and in 
the “SIMATIC Process Control System PCS 7 CFC for SIMATIC S7 (V8.2)” 
function manual. 

 

This chapter will describe as an example how to add a new connection to the block 
and then load this change into the CPU 410-5H in RUN mode.  

Requirements 

The following requirements apply: 

• A PCS 7 multiproject is open in the SIMATIC Manager. 

• The automation program has been compiled and loaded into the CPU 410-5H PA. 

• Loading of the automation program was carried out with a CFC of Version V8.1 
(or above) 

• The firmware of the CPU 410-5H PA is V8.1 (or above) 

• There is enough storage space on the CPU for modified blocks 

• There are enough reserve POs on the CPU 
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Making interface changes  

Open the master data library for the project in component view. 

1. Open the "Sources" folder. 

2. Open the SCL source for the desired block type. 

 

 

3. Carry out the desired changes. 
In this example, the connection "LOCK_2" will be added for an additional 
interlock on the block. 

 

 

4. Save the changes and compile the SCL program. 

5. Close the SCL source. 
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Loading interface changes in RUN mode  

1. Select the "Blocks" folder in the master data library. 

2. Carry out command "Extras > Charts > Update block types". 
The "Update block types" dialog opens. 

3. Select the check box in the "Download in RUN" column and click on the 
"Calculate" button in the "Resources" column. 

 

The "Resource information" dialog opens. This contains information about resource 
requirements for type changing in the automation system in which the type change 
is carried out. 
 

 
 

 

  

Note If not enough resources are available, loading is only possible via STOP. 
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4. Close the "Resource information" dialog. 

5. In the "Update block types” dialog, click on the “Next” pushbutton. 
In this step, the display shows whether the type change can be carried out in 
the RUN state on the basis of the calculation in the "Consequence" field.  

 

6. Click "Finish". Wait until the updating procedure has completed successfully. 
A log file is displayed at the end of the procedure. 

7. Select the "Charts" folder for the AS program and open a CFC chart. 

The message "TCiR: Download required!" is displayed on the status bar. 
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8. Click the "Load" button on the toolbar. 
The "Compile program/Download to target system" dialog opens. 

9. Select the "Entire program" option on the "Compile charts as program" tab. 

 

 

10. Open the "S7 download" tab and select the "Changes only" option. 

 
 

11. Click the "OK" button. 
The interface changes are downloaded into the CPU 410-5H in RUN mode. 
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2.3 Using TCiR to update a library 

Requirements 

When updating an entire library, the same conditions and rules apply as to 
updating of an individual block. 
 

Note In general, upgrading using TCIR should have the aim of not stopping the AS but 
not demand migration of the project (the plant) to Run Time. 

 

CAUTION Note that you must create new blocks (new number) for the instances of 
the changed block types that were loaded into the CPU by means of TCiR. 
The system deactivates the blocks in WinCC until the OS server has be 
been re-compiled and loaded. 

In the case of a redundant OS server, you can do this before loading AS 
TCiR and loading one of the servers. This means that the plant can be 
operated before and after AS TCiR loading. 

Note, however, that when doing this data can be lost in the area of 
archiving. 

 

Note You can find a detailed description of TCiR in the CFC online help system and in 
the “SIMATIC Process Control System PCS 7 CFC for SIMATIC S7 (V8.2)” 
function manual. 

 

The procedure for updating a library is described in the “Information and brief 
instructions for updating/upgrading PCS 7 software” manuals 
(https://support.industry.siemens.com/cs/ww/en/view/39980937). 

License check 

Note that at updating, more AS RT POs may be needed temporarily. This is the 
case if counting of AS RT PO is carried out in the CPU by the assigned memory. 

To ensure that enough POs are available, proceed as described below. 

1. Right-click the multiproject. 

2. Select the “PCS 7 license information” menu item. 

3. Make a note of the number of configured and booked POs and the maximum 
number of POs. 

4. Check whether the AS RT counts the POs according to the assigned memory. 
 

Note You can find detailed information on PO counting in the FAQ entitled “How are 
the licenses for the AS and OS counted in PCS 7 V7.0 onwards?“ in the Industry 
Online Support system. 

 

If AS RT POs are not counted according to the assigned memory or if adequate 
spare POs are available, continue with “Resource Checking” in this chapter.  

https://support.industry.siemens.com/cs/ww/en/view/39980937
https://support.industry.siemens.com/cs/ww/en/view/38855207
https://support.industry.siemens.com/cs/ww/en/view/38855207
https://support.industry.siemens.com/cs/ww/en/view/38855207
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If the AS RT counts the POs according to the assigned memory, load the program 
via STOP. 

CAUTION If not enough AS RT POs are available on the CPU, downloading is not 
carried out. It is then only possible to update the user program by overall 
loading in STOP mode. 

 

Resource checking 

After updating the blocks in the master data library, proceed as described below. 

1. Select the "Blocks" folder in the master data library. 

Carry out command "Extras > Charts > Update block types". 
The "Update block types" dialog opens. 

2. Select the check box in the "Download in RUN" column and click on the 
"Calculate" button in the "Resources" column. 

 

The "Resource information" dialog opens. This contains information about resource 
requirements for type changing in the automation system in which the type change 
is made. 
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3. Check whether the there are adequate resources: 
If there are, proceed as described in chapter 2.2 from step 4 onward.  
 

Note If not enough resources are available, loading is only possible via STOP. 

 

 

2.4 Configuring the PN/Ethernet interfaces of the CPU 410-5H  

In this chapter you will find information about configuration options for the PN/Ethernet 
interfaces of the CPU 410-5H. 

2.4.1 Configuring the interfaces for connection to the plant bus and the 
process bus without using an external CP 

Due to its two PN/Ethernet interfaces, the CPU 410-5H can provide the option of 
implementing a connection to the plant bus and the process bus without using an 
external CP. This yields the following benefits: 

• Reduction of hardware costs 

• More space due to the use of compact mounting racks 

The configuration procedure is carried out in the following steps: 

• Adding a new AS station to the project 

• Configure the interface for the plant bus 

• Configuring the interface for the process bus 

The following figure shows the configuration schematically: 
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Requirements 

The following requirements must be met: 

• There is a PCS 7 multiproject present. 

• A CPU 410-5H is connected. 

Adding a new AS station to the project 

1. Open a PCS 7 multiproject in the SIMATIC Manager. 

2. Insert a new sub-project using the "File > New project" command. 

3. Right-click on the sub-project and choose the "Insert new object > 
Preconfigured station“ command from the context menu. 
The "PCS 7 Wizard: Expand project" dialog opens. 

4. Select the CPU 410-5H without CP and insert the station. In this example, the 
procedure is explained using the example of a single station (AS410-Single (1H)). 

5. Open the AS station with the CPU 410-5H in HW Config. 

 

Configure the interface for the plant bus 

1. Open the properties for the "PN-IO-X5" interface of the CPU 410-5H in the HW 
Config. 
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2. Enter a device name in the "General" tab.  
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3. Click on the "Properties..." button. 

4. Enter a valid IP address and subnet mask for the plant bus. 

 

 

5. Assign an existing subnet to the interface or create a new subnet for it.  
In this example, a new subnet is created for the plant bus and assigned to 
the interface.  

 

 

6. Click the "OK" button to confirm the settings. 
The interface is connected to the plant bus. 
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Configuring the interface for the process bus 

1. Open the properties for the "PN-IO-X8" interface of the CPU 410-5H in the HW 
Config. 

2. Right-click the "PN-IO-X8" interface and select the "Insert PROFINET IO 
system" command from the context menu. 

 

The "Properties..." dialog opens. 
 

3. Enter a valid IP address and subnet mask for the process bus. 

4. Assign an existing subnet to the interface or create a new subnet for it.  
In this example, a new subnet is created for the process bus and assigned to 
the interface. 
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5. Click the "OK" button to confirm the settings. 
A PROFINET IO system for connecting the PROFINET IO modules is created. 

 

 

Further information on planning the PROFINET interface can be found in the 
application example "SIMATIC PCS 7 with PROFINET – Typical Configurations" 
(Chapter 4, "Configuration, Planning and Parameter Setting").   

http://support.automation.siemens.com/WW/view/en/72887082
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2.4.2 Configuring two separate PROFINET interfaces for connection to the 
process bus 

When there is a large number of devices, the CPU 410-5 offers the option of 
configuring two PROFINET interfaces for connection to the process bus. In this 
case, the connection to the plant bus is made via an external CP. 

The configuration procedure is carried out in the following steps: 

• Adding a new AS station to the project 

• Configure the interface for the plant bus 

• Configuring two PROFINET interfaces for the process bus 

The following figure shows the configuration schematically: 
 

  

Requirements  

The following requirements must be met: 

• There is a PCS 7 multiproject present. 

• A CPU 410-5H is connected. 
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Adding a new AS station to the project 

Proceed as follows to configure two PROFINET interfaces for the process bus: 

1. Open a PCS 7 multiproject in the SIMATIC Manager. 

2. Insert a new sub-project using the "File > New project" command. 

3. Right-click on the sub-project and choose the "Insert new object > 
Preconfigured station“ command from the context menu. 
The "PCS 7 Wizard: Expand project" dialog opens. 

4. Select the CPU 410-5H with a CP and insert the station. In this example, the 
procedure is explained using the example of a single station (AS410-Single 
(1H)) with a CP 443-1. 

Configure the interface for the plant bus 

5. Open the AS station with the CPU 410-5H in the HW Config. 

6. Open the properties for the "PN-IO" interface of the CP 443-1. 
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7. Open the "General" tab and enter a meaningful device name. 

 

 

8. Click on the "Properties..." button. 

9. Enter a valid IP address and subnet mask for the plant bus. 

10. Assign an existing subnet to the interface or create a new subnet for it. 

 

11. Click the "OK" button to confirm the settings. 
The interface of the CP443-1 is connected to the plant bus. 
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Configuring the PROFINET interfaces for the process bus 

12. Open the HW Config. 

13. Open the properties for the "PN-IO-X5" interface of the CPU 410-5H in the 
HW Config. 

14. Right-click the "PN-IO-X5" interface and select the "Insert PROFINET IO 
system" command from the context menu. 
The “Properties” dialog of the interfaces opens. 

15. Enter a valid IP address and subnet mask. 

16. Assign an existing subnet to the interface or create a new subnet for it. In this 
example, a new subnet ("Processbus_AS02_1") is created for the process bus 
and assigned to the interface. 

 

 

  



2 Application scenarios 

2.4 Configuring the PN/Ethernet interfaces of the CPU 410-5H 
 

Process automation with the SIMATIC PCS 7 CPU 410-5H controller 
Entry ID: 96839331,    V2.2,    11/2016   43 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

17. Click the "OK" button to confirm the settings. 
PROFINET IO system "Processbus_AS02_1" is assigned to the interface. 
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18. Right-click the "PN-IO-X8" interface and select the "Insert PROFINET IO 
system" command from the context menu. 
The “Properties” dialog of the interfaces opens. 

 

 

19. Enter a valid IP address and subnet mask. 

20. Assign an existing subnet to the interface or create a new subnet for it.  
In this example, a new subnet ("Processbus_AS02_2") is created for the 
process bus and assigned to the interface. 
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21. Click the "OK" button to confirm the settings. 
PROFINET IO-System “Processbus_AS02_2” is assigned to the interface. 

 

 

Further information on planning the PROFINET interface can be found in the 
application example "SIMATIC PCS 7 with PROFINET – Typical Configurations" 
(Chapter 4, "Configuration, Planning and Parameter Setting").   

 

  

http://support.automation.siemens.com/WW/view/en/72887082
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2.5 Online upgrading of CPU 410-5H process objects 

2.5.1 Introduction 

When you load a PCS 7 project into the CPU, the system checks that the project 
can run with the current number of process objects (POs) in the CPU.  

If the number is not sufficient, starting with PCS 7 V8.1 you have the option of 
increasing the PO volume by means of an online upgrade of the CPU 410-5H 
system expansion card (SEC). 

Prerequisites for an online upgrade 

• SIMATIC PCS 7 V8.1 or higher 

• CPU 410-5H firmware V8.1 or higher 

• The CPU 410-5H is configured with firmware V8.1 or higher in the HW Config  

• The SEC of the CPU 410-5H has the product version 2 or higher 

CPU 410 expansion packs 

You will need at least one CPU 410 expansion pack for the online upgrade of the 
process objects of a CPU 410-5H.  

The CPU expansion packs are available in the following sizes: 

• 100 POs 

• 500 POs 

The expansion packs can be combined in any way up to the maximum size. Note, 
however, that with a redundant system (2 CPUs), the CPU 410 expansion packs 
must be distributed symmetrically between the CPUs. 

The volume of a CPU expansion pack must always be assigned in its entirety to a 
CPU or SEC of the CPU. Distribution between several CPUs or SECs is not possible.  

After a PO upgrade, the POs that are assigned to an SEC/CPU can no longer be 
relocated. 

Example 

If the number of POs in the CPU is not sufficient to load the engineering project, 
you can increase the PO volume of the CPU by means of an online upgrade. 
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Table 2-1 

Expanding by 300 PO (from 400 PO to 700 PO) 

 

With a single AS, to increase the number of POs by 
300 you need 3 CPU 410 expansion packs with 100 
POs each. 

 

With a redundant AS (2 CPUs), to increase the 
number of POs by 300 you need 6 CPU 410 
expansion packs, with 100 POs each. This is 
necessary, since both CPUs must be expanded by 
300 POs. 

In this case, you cannot combine expansion packs 
with 500 POs and 100 POs, since the PO volume of 
an expansion pack cannot be subdivided.   

 

 

The table below contains further examples:  

Table 2-2 

PO expansion  
by  

 

CPU 410 expansion packs needed 

 

Single AS Redundant AS 

400 POs  4  x 100 POs 8 x 100 POs 

500 POs 1 x 500 POs or 

5 x 100 POs 

2 x 500 POs or 

10 x 100 POs 

600 POs 1 x 500 POs + 1 x 100 POs or 

6 x 100 POs 

2 x 500 POs + 2 x 100 POs or 

12 x 100 POs 

1000 POs 2 x 500 POs or 

10 x 100 POs 

4 x 500 POs or  

20 x 100 POs 
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Unlimited POs 

The number of POs can be upgraded to unlimited. In this case you can load as 
many POs until the physical memory is reached. To upgrade the POs to an 
unlimited amount there are two ways: 
 

• Purchase of a CPU410-5H bundle with 2K+ PO as license. 
(Article number: 6ES7654-5CQ00-0XF0) 
 

• Upgrade the existing number of POs with CPU expansion packs 100 and 
500 until there are 2600 POs on the SEC. With 2600 POs on a SEC you 
can load unlimited POs to a CPU410-5H. 
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2.5.2 Overview of the steps  

The online upgrade is carried out in the following main steps: 

Table 2-3 

Schematic representation Step 

 

1. Order the CPU 410 expansion packs. 

 

 

2. In the SIMATIC Automation License Manager 
(ALM), transfer the CPU 410 expansion packs to 
the CPU and create a PO activation file. 

 

3. Send the PO activation file for checking and 
activation by means of a support request. 
 
Within 48 hours, you will receive by e-mail a PO 
release file (for each PO activation file sent) as 
confirmation of checking.  

 

4. Transfer the PO release file to the SEC of the 
CPU using the ALM. 

 

NOTE With a redundant configured AS only one CPU is selected. The distribution of the 
POs on both CPUs automatically occurs. 
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CAUTION When performing an online upgrade of the process objects, pay attention 
to the information and notes in the manual "SIMATIC PCS 7 Service 
Support and Diagnostics (V8.2)". 

 

2.5.3 Order the CPU 410 expansion packs 

You have the following options when ordering CPU 410 expansion packs: 

• Through your Siemens contact person (www.siemens.com/automation/partner) 

• Online via www.siemens.com/industrymall 

 

 

After you have received the CPU 410 expansion packs (by e-mail or USB stick), 
transfer them to a disk drive that can be accessed by the Engineering Station. 

  

file:///C:/Users/z003thbf/Downloads/www.siemens.com/automation/partner
http://www.siemens.com/industrymall
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2.5.4 Creating the PO activation file using the Automation License Manager 
(ALM) 

1. Store the CPU 410 expansion packs on a drive that can be accessed in the 
Automation License Manager (ALM). 

 

2. Select menu command "Edit > Connect target system > Connect/disconnect 
AS 410...". 

 

 

The "Connect Target System" dialog opens. 
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3. Click on the "Add" button to establish an on-line connection to a CPU 410-5H. 

 

 

4. In the PCS 7 project, select the CPU to which you want to transfer the CPU 
410 expansion packs or PO. Then click on the "OK" button. 

 

The CPU is displayed in the ALM. 
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5. Drag the license keys for the CPU 410 expansion packs and drop them on to 
the automation system for which you want to perform the PO upgrade.  

 
 

Note If you have selected the wrong automation system, you can move the license 
keys for the CPU 410 expansion packs by dragging and dropping. 
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6. Open the "Online" folder in tree view for the automation system.  

7. Select the license and then select the "License Key > Upgrade" menu command. 

 

CAUTION When you initiate the upgrade, the selected CPU 410 expansion packs are 
assigned to the SEC. Moving to another AS is no longer possible. 

 

 

 

The license keys for the selected CPU 410 expansion packs are deleted and a PO 
activation file is created in the "Your document > Siemens > Automation > PCS 7 > 
Activations" folder.  

The ALM indicates that the PO activation file contains a volume expansion  
(in this example, from 600 to 700).  
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2.5.5 Sending the PO activation file via a Support Request 

The Activation File is now sent to the Technical Support via Support Request in 
order to receive a Release File: 

1. First start a Support Request via the website 
https://support.industry.siemens.com/cs/my/src?lc=en-WW. 
 

Abbildung 2-1 

 

 

2. Step "Search product": 

– Enter "CPU 410" in the entry field "Product/Order number" and click on the 
button "Find" (1). 

– Click on the "Next" button (2).

1

2

 
 

https://support.industry.siemens.com/cs/my/src?lc=en-WW
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3. In the register "Problem description", in the area "First help for the selected 
product", you will find contributions which can help you with your problem (1). 

4. Describe the problem. 

– Make the entries in the mandatory fields (2). 

– Enter the text "Request Release-File" in the entry field "Details of the 
Request" (3). 

– - Insert the activation file as a zip file by clicking or by dragging & dropping 
the activation file on the area "Move your files ("Drag and drop") into this 
field or click to select files" (4). 

– Click on the "Next" button (5). 

21 3

4

5

 

 
 

Note Activation files are automatically created in the following Upgrade directory in the 
Engineering Station:  
"Documents > Siemens > Automation > PCS7 > Activations" 
("C:\Users\\Documents\Siemens\Automation\PCS 7\Activations") stands for your 
Windows username 

 

Note You can send several activation files with one support request. 

 

5. "Specify contact data" step: Specify your contact data, then click on the "Next" 
button.  

6. "Summary and send" step: Check your details, then click on the "Send" button. 
Within 48 hours you will receive an e-mail containing a release file for each 
activation file sent. 
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2.5.6 Transferring the PO release file to the SEC of the CPU 

1. Transfer the received PO release files to the Upgrade directory in the Engineering 
Station:  
"Your documents > Siemens > Automation > PCS7 > Activations". 

2. Open the Automation License Manager (ALM). 
The automation systems that are connected to the Automation License 
Manager are shown in the list in the "Connect AS 410" dialog box. 

3. Click on the "Add" button to connect a further automation system. In the PCS 7 
project, select the CPU to which you want to transfer the PO release file. Then 
click on the "OK" button. 

 

 

The CPU is displayed in the ALM. 

4. Drag the PO release file and drop it on to the "Online" folder of the desired 
automation system. 

 

The upgrade is carried out. The time that is taken depends on the loading of the 
automation system. 

After an upgrade is completed, the files (PO release file and PO activation file) that 
are used in the Upgrade directory are deleted. 
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The Automation License Manager shows the new number of POs for the updated SEC.  

 

 

Note You can also call up the volume of the SEC, as well as the process objects that 
are subject to license, in the SIMATIC Manager under "Extras > PCS 7 license 
information".  

 

2.6 Additional information 

2.6.1 Replacing an existing CPU with the CPU 410-5H  

An existing CPU in the S7-400 series can be replaced by the CPU 410-5H with 
little effort. In addition to the replacing the hardware, some adaptations must also 
be made to the hardware configuration of the PCS 7 project. You will find extensive 
information about this at 
https://support.industry.siemens.com/cs/ww/en/view/85014617. 

 

2.6.2 Extending availability 

With the standard SIMATIC PCS 7 AS 410 automation system, you already have 
the option of selectively increasing the availability by means of redundant 
configuration of the Industrial Ethernet communications module. 

With its redundant CPUs, the Type AS 410H redundancy station offers 
considerably greater availability. It works on the 1 of 2 principle, where the reserve 
system is switched in if there is a failure of the active subsystem. Starting from 
here, you can double the power supply or the Industrial Ethernet communications 
module for each subsystem and combine these measures. 

You can find extensive information about the procedure for expanding a Single 
Station to a Redundancy Station at 
https://support.industry.siemens.com/cs/ww/en/view/82523363. 

 

 

 

https://support.industry.siemens.com/cs/ww/en/view/85014617
https://support.industry.siemens.com/cs/ww/en/view/85014617
https://support.industry.siemens.com/cs/ww/en/view/82523363
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http://support.industry.siemens.com 
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SIMATIC PCS 7 CPU 410-5H 
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https://support.industry.siemens.com/cs/ww/en/
view/96839331https://support.industry.siemens.co

m/cs/ww/en/view/96839331 

 

\3\ SIMATIC PCS 7 process control 
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System PCS 7 Service support 
and diagnostics (V8.2) 
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